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The license of Plotter 

Only when you accept all clauses in this license agreement about using 

Plottersoftware (hereinafter called the agreement for short), will our company 

authorize you to use Plottersoftware and relevant documents. So please read the 

agreement carefully before you choose to accept or not to accept the agreement. If 

you don’t accept the agreement, our company will not authorize you any right to use 

this software. If you accept the agreement, you will be one party of the agreement and 

should comply with the following agreement as soon as you start to use this software. 

1.  The name of our company is BOYE LASER APPLIED TECHNOLOGY CO., 

LTD. Or BOYE for short. Our company is the legal owner of the property right 

of this software and relevant documents. 

2.  Plottersoftware can only be used with BOYE laser working and engraving 

machines. They are not sold alone. You are not allowed to use this software 

alone without buying our machines.  

3.  You have the limited right to use this software. You can only install and run this 

software in one computer. Our company is the only legal owner of property 

right of this software and relevant documents whether it is in the optical disk 

you bought or installed in your computer. 

4.  Our sole ownership of this software is protected by Chinese and international 

laws, regulations and agreements of intellectual property. 

5.  The following actions will cause strict civil punishment or bring a suit against 

you. 

   ■Try to spy upon the source code of the software. 

   ■Copy, change, distribute and retail the software. 

   ■The actions mentioned in the fifth clause include but are not confined to 

making the illegal copy, amending, reprogramming, compiling, un-compiling 

or other reverse engineering activities.  

6.  The older version of our software can be upgraded by visiting 

http://www.boye.com.cn. The customers holding the upgraded software should 

comply with all the clauses in this agreement. If the agreement of the older 
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version conflicts with this agreement, this agreement takes priority.  

7.  This agreement will take effect when you buy the software or upgrade your 

older version. If you reject this agreement, you give up the right to use the 

software as the agreement indicated. You must delete and destroy the software 

and all the copies, and bear all the relevant loss and responsibility. 

8.  Our company reserves the right to interpret and modify this agreement. 

 

There are several cautions relating to safety as follows in 

this manual: 

  

This sign shows that something should be note when   

operation. 

 

This sign offers some useful information or some operate skill.  

 

 Announce: because of that specific requirements or parts of 

construction and contents make changes as caused by 

technical upgrade for users，we will not inform you again. 

 

Trademark Notice  

The product name covered in this manual is only used for 

identification purposes, and these names may belong to various other 

trademarks or copyrights, here states as following:  

※WINDOWS,Windows 7,Windows XP are all the Product 

identification of the MICROSOFT Corporation.  

※Plotter, CA-II are the trademarks of BOYE LASER APPLIED 

TECHNOLOGY CO.,LTD. 

    ※The other unmentioned identities are owned by the registered 

companies.
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1.INTRODUCTION 

1.1.Computer Requirement 

1.1.1.Hardware Environment 

100%IBM Compatible PC or Industrial Computer, With Memory of 256M or 

above, 10/100M Network Card, CD-ROM, VGA Color Display and above 100M 

Hard Disk free space.     

1.1.2.Software Environment 

    Plotter software should run under the Windows setting, So customers are 

required of installing the Operating System of Windows 7 or Windows XP. 

1.1.3.Compatible Device 

Plotter V1.2 software supports BOYE processing devices that contain BY 

control system. 

1.2.Software Installation and Operation 

1.2.1.Software Installation 

■ Start Windows operating system and correct the system current time (Note: If 

the time is wrong, Plotter will not operate correctly);  

■ From the Plotter installation disk and put into CD-ROM, install Plotter 

software in your computer; 

■ Start operation according to the related prompt;  

■ After installation complete, installation will create Plotter shortcuts in your 

Start menu and your desktop. 

1.2.2.Add Device 

■ Double click the icon of Plotter , Startup Plotter to enter interface 

(Fig.1-2-1) ˗ 

■ Click the add button, Input device name˄Fig.1-2-2˅˗ 
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■ Input the twenty-one-digit serial number˄Fig.1-2-3˅˗ 

■ Click “OK” button to enter Plotter software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

˄Fig.1-2-1˅ 

  

 

 

 

˄Fig.1-2-2˅                         ˄Fig.1-2-3˅ 

1⃝ To upgrade Plotter, please uninstall the old version of the 

software, then to install; 

2⃝ Uninstall the software operation will remove some user 

information under the software installation path, please 

backup in time; Particular, you can backup the ini folder 

under the installation path, after installation, replace the ini 

folder you just installed by the backup files, so you may not 

re-enter the device serial number and the system parameters. 
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1.3.PlotterGraphic User Interface 

To start the software: double click the icon of Plotter, you can enter 

PlotterSystem. You will see a window as below:  

 

 

 

 

 

 

 

 

 

 

 

 

 

˄ Fig.1-3-1˅ 

More detail information please refer to the related chapter of “Basic knowledge”.  

1.4.The Characteristics of Plotter 

� Undo/Redo functionalities to make editing much easier and more fun; 

� Adopt 32 bit programming technology, has system-level linear and circular 

interpolation function; 

After adding the device, please close and restart the 

software again, so the related equipment information 

can be saved to the related catalog. 
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� Able to input and save multiple device information, and choose one as the 

current device. When you change the current device, the device parameters 

(in System Setting, Motion Setting under Settings menu) will change with it. 

So that you can go on several of operation and control for multiple devices 

by this software; 

� Able to import existing files into current documents to enable you to utilize 

multiple graphic or image files. Support PLT, BMP (1bit), DXF (R12), DST 

(SPIN Serial) and HPG file format; 

� Able to select one or more graphic elements and apply editing operations 

such as mirroring, transforming, duplicating, rotating distorting, alignment, 

changing color to them. Able to do minor adjustment to the positions of the 

selected graphics elements using arrow keys. Able to edit graphic expediently 

with the function of nesting groups, which a group can be one element within 

another group.  

� Able to insert text in chosen font. Able to produce the envelope curve or the 

outline for the closed path; 

� Grid support for more precise positioning; 

� The software offer data recording function.It can select the numbers entered 

before; 
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2.Basic Knowledge 

2.1.Enter and Exit the System 

2.1.1.Enter the System 

Double click the icon of Plottert enter Plotter software. 

2.1.2.Exit the System 

There are three methods to exit the system; 

■ Click the exit button on the right up corner of the main windows of the 

system; 

■ Select the exit in the File menu; 

■ Press the quick key ALT+F4⃞ 

2.2.Shortcut Key 

Shortcut 

Key 
Functions Function Declaration 

F1 Using Help Open the help file of system 

F2 Speed Setting Set the parameters of graphics 

F3 Graphics Display all the graphics in the screen 

F4 Work Area 
All the screen display the selected 

graphics 

F5 Run Setting Selective output the run dates 

F6 Run All Output the run dates 

F7 Selected Preview 
Imitate the system running path and 

time 

F8 System Setting Setting every parameter for system 

CTRL+N New Create a new blank page 

CTRL+O Open Open the saved*.ble file 
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CTRL+I Import Import graphics in different formats  

CTRL+S Save Save the *.ble file in the current page 

CTRL+Z Undo Undo the previous operation 

CTRL+Y Redo Redo to the previous graphics 

CTRL+A Select All Select all the graphics in current page 

CTRL+C Copy Copy the selected graphics 

CTRL+V Paste 
Paste the selected graphics to the  

current page 

CTRL+G  Group 
Combine the selected graphic elements 

into a group 

CTRL+U Ungroup 
Release the group to make the elements 

within the group appear as themselves. 

 

 

 

2.3.Tool Bar 

 

(Fig.2-3-1) 

The icon in the tool bar is the common functions of the system; it shows the 

common tools in the menu. Move the cursor on each button, the system will display a 

brief explanation about this tool in the left side of the status bar.From left to right:  

New  Open  Import  Save  

Output to 

off-line file 
 Undo  Redo  Copy  

Paste  Graphics  Work Area  Zoom  

Hold down the mouse button and move the mouse, drag the 

entire canvas 
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2.3.1.Group(G) 

Combine the selected graphic elements into a group. All elements within a group 

will appear as one element. You can also use shortcut key Ctrl-G. A Group can be one 

element within another group, and a group must contain more than one element. 

2.3.2.UnGroup(N) 

Release the group to make the elements within the group appear as themselves. 

You can also use shortcut key Ctrl-U. 

2.3.3.Sort(O) 

Order the selected graphic elements in the work area. Used to change the order 

that graphic elements are outputted. There are six methods of ordering, including 

three automatic methods: By Row, By Column, Closest First and three manual 

methods: Input Order, Click Ordering and Mouse Guided Ordering. Advice to use 

automatic method first and do fine tuning later manually.   

How to operate:  

Click “Order” in Edit menu or click icon  in the toolbar to enter 

ordering mode. Press the right mouse button to bring up the following menu. 

(Fig.2-3-3)  

 

 

 

 

      (Fig.2-3-3)                       (Fig.2-3-4)   

Group  Ungroup 
 

Order  
Batch 

Reproduce 
 

Change to 

graph 
 Run All  Preview All  
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1.Enter Ordinal : Select a graphic element and choose Input Order will bring up 

a dialog as in Fig.3-4-3. You can type in an order number directly to 

change the order of the selected graphic element.  

2.Enter Group: Enter a group to edit the order of graphic sub-elements within 

the group. 

3.Leave Group: Leave the current group and go back to the root level. 

4.Click Sorting: Click on each graphic element in the order you want, and they 

will be ordered according to the order you clicked. 

5.Auto Sort: After clicks on the Auto Ordering, the following ordering menu 

appears:  

 

 

 

 

                              (Fig.2-3-5) 

By Row: Order the graphic elements row by row according to given height; 

By Column: Order the graphic elements column by column according to 

given width of the column; 

Closet First: Start from the top-left corner of the working area, and order by 

choosing the closest element as the next one after finishing ordering the 

elements within the scan radius; 

radius: When select the Closet First, the last graphic within the scan radius 

takes priority; 

Optimize Path Start: Change the origin of the graphic when in the process 

of ordering so that to make theworking optimizes; 

       Automatic sorting imported graphics:According to the  

       customer‘s demand,increase the function of import graphics,the  
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       graphics use the shortest sort method automatically.the premise is  

       the graphics which to be imported can not exceed the size of the  

       area which the software setting in it,if exceed the area,it must do  

       sort operation by yourself; 

       All: If not checked, will treat the group just as an element; while  

       if checked, will also order the elements with a group. 

6.Mouse Guided Sorting: Clicks on the Start Mouse Guided Ordering to enter 

the Mouse Guided Ordering state. Then press the left mouse button 

and drag, and the graphic elements will be ordered according to the 

path your mouse moved. If all graph elements in the working area are 

ordered, the system will automatically end the Mouse Guided 

Ordering. You may also click on “End Mouse Guided Ordering” to 

end, and the remaining graphic elements will stay in the original order. 

7.Optimize Path Start: Optimize the path start to reduce the total operation 

time.  

8.Color order :“Placed to top” operation will make the currently selected color 

working order to route to the front, “Placed to end” operation will 

make the currently selected color working order routed to the end, 

“Up""and “Down” will make the currently Selected color working 

order move up and down a bit.             

            

 

                        

 

 

 

Mouse Guide Ordering follows a principle: When an 

element encloses other elements (called sub-elements), 

the sub-elements have to be ordered first for the laser 

working purpose. Ordering By Row or By Column 

goes in the shape of letter S to reduce machine 

The graphics can not be a combination when do  

perform color sorting) 
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2.3.4.Batch Replicate(B) 

Reproduce the graphic according to the quantity and interval in the Batch 

Reproduce dialog. 

How to operate:  

Select graphic elements to be reproduced, click icon  in the toolbar or 

select “Batch Reproduce” in Edit menu, and Batch Reproduce dialog will appear 

as in Fig.2-3-6. 

 

 

 

 

 

 

 

 

    (Fig.2-3-6) 

Specific instruction:  

Quantity: Number of copies to generate horizontally or vertically; 

Interval: Distance from border to border between copies horizontally or vertically; 

Full In Work Area: Select this item, click “OK” key to make the system auto 

generate one batch of the same graphic that arranged full surface; 

Fill Area: Select this item, click “OK” key to make the system auto generate one 

batch of the same graphic that fill the specified area. 

2.4 Transform Bar 

 

 

(Fig.2-4-1) 
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Used to localize and zoom the selected graphics. 

2.5.Color Bar 

 

 (Fig.2-5-1) 

The Color Bar is used to change the color of the selected graphics by clicking the 

button in the toolbar. 

 

 

2.6.Alignment Bar 

 

(Fig.2-6-1) 

The icon in the alignment bar is the common ways for alignment. Move the 

cursor on each button, the system will display a brief explanation about this tool in the 

left side of the status bar.From left to right: 

Align Left  
Align Vertical 

Center 
 

Align 

Right 
 

Align 

Top 
 

Align 

Horizontal 

Center 

 Align Bottom  
Align 

Center 
   

Horizontal 

distance 
 

Vertical 

distance 

 
Lock  Rotate  

Polygon 

Setting 

 
H-Mirror  V-Mirror  

Paintbrush 

color 
 

Colors of 

selected 

graphics 

 Location 

of selected 

graphics 

 

Type  

The last button can be used to self-define the color by the color 

palette. 
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2.7.Insert Tool Bar 

      

(Fig.2-7-1) 

The icon in the Insert Tool Bar is the common tools for drawing and inserting. 

Move the cursor on each button, the system will display a brief explanation about this 

tool in the left side of the status bar.From left to right:   

Draw ellipse  Draw rectangle Draw Circle  

Draw lines  Draw Arc Draw Spline  

Draw polygon  Insert text Insert Location Frame  

Insert file no.      

2.8.Curve Editing Bar 

 (Fig.2-8-1)  

The Curve Editing Bar contains icons for curve editing tools. It can add/delete 

some nodes from the curve, break the curves, and close the curves. Move the cursor 

on each button, the system will display a brief explanation about this tool in the left 

side of the status bar.From left to right:  

Node 

Editing  

Make 

Closed  
Add Node 

 

Delete 

Node  

Change 

Start 

Point 
 

Break 

Apart  
Link Up 

 

Change To 

Curve  

Change 

To Line  

Delete 

Segment  
Locate Node 

 

Merge 

lines  

Split 

graph  

Fill 

Graphics  

Delete 

SuperPosition    
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2.9.Control Flat Bar 

Can read the relevant file information of device through 

Control Flat Bar. 

Device: Contains the current selected device name and IP 

address; 

File Information: Display the file name in the opposite 

order of memory files, and do delete, run, 

pause,continue,terminated operation to file or see the 

current file information, make the equipment empty will 

delete all the files on the device and do formatting 

operations for the file system; 

Direction Key: To control the head moving; 

Keyboard Control: Use the direction key on       

keyboard; 

 

 

 

 

 

 

 

 

 

 

1.Do any operation on the file, you must select the response 

file; 

2.To delete the file, you can select multiple files by shift + left 

mouse button to delete together. 
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3.Basic Operations 

3.1.Basic Operating Process 

■ Set the parameters in motor setting, motion setting and through the setting 

menu, set the machine state through the Device Information Bar, make sure 

the parameters in device is same to parameters in software; 

 

 

 

 

 

 

 

■ Make the graphics or read the graphics file in other file; 
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■  According to the file, set appropriate parameters.(Double-clicked  the 

selected graphic); 

 

 

 

 

 

 

 

 

 

■ Execute the drawing work. 
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3.2.Editing with Mouse 

3.2.1.Select 

■ To select a graphic element, just click on it. When selected, there will be 

eight small squares shown around the element and one “x” shown in the 

center; 

■ To select multi-graphic elements, press the left mouse button, hold it, and 

drag a rectangle to cover the graphic elements and one “x” shown in the 

center; 

■ To select a compound, you can just click on it ,you will see two empty 

squares in the center instead of “x”. 

3.2.2.Move 

Select the graphic element, and move the cursor to the center, you will see that 

the cursor becomes “+”. Then press the left mouse button and drag, the graphic 

element will move with your mouse move. 

Select the graphics,press the button SHIFT, Using the mouse to drag the 

graphics,figure move only in X or Y direction.The graphics will move on the direction 

which the mouse move nearly. 

3.2.3.Zoom 

Select the graphic element, and move the cursor to one of eight small squares, 

the cursor becomes double arrowhead icon. Then press the left mouse button and 

drag, the graphic element will zoom with your mouse move.  

3.2.4.Rotate 

Click the selected graphic element again to get into rotate/distort mode, the 

selection display will become four short lines on four sides, four short curves around 

the corners, and the icon  in the center. The icon represents the reference point 

for rotation, and you can move it by mouse. Move the cursor to the one short curve 
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of the four short curves, press the left mouse button and drag, the graphic element 

will rotate with your mouse move around the reference point. 

3.2.5.Distort 

Click the selected graphic element to get into rotate/distort mode. Then move the 

cursor to one of the short lines on the sides, press the left mouse button and drag, the 

graphic element will distort with your mouse move around the center. 

3.2.6.Grab 

Press the Mouse middle button, the mouse will become the icon ,  

then press the right mouse to drag the window at will.  

3.3.File Menu 

Click File in the Menu Bar, the following menu appears: 

 

 

 

 

 

 

 

 

  (Fig.3-3-1) 

3.3.1.New(N) 

Create a new document. You can also click the icon  in the toolbar or use 

shortcut key Ctrl-N. 

3.3.2.Open(O) 

Open an existing file. You can also click the icon  in the toolbar or use shortcut 

key Ctrl-O. Can open 5 file formats: PLT.BMP.DXF.DST.HPG and BLE. Among 
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them BLE is the main file format and the only one Plottercan save to. 

Through the “menu”-“file”-“open”or“open”button in the commonly used 

toolbar,pop dialog box “open”,as show in Fig3-3-2.The file type increases the bitmap 

format selection. 

 

                    (Fig3-3-2) 

3.3.3.Import(I) 

Import an existing file and merge it into the current document. You can also click 

the icon  in the toolbar or use shortcut key Ctrl-I. Can import 5 file formats: 

PLT.BMP.DXF.DST.HPG and ai, the software supports preview function when 

choosing a file. 

3.3.4.Close (C) 

Close the current document. 

3.3.5.Save(S) 

Save the current document to the corresponding BLE file. The settings  are 

saved along with graphic information. You can also click the icon  in the toolbar 
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or use shortcut key Ctrl-S. 

3.3.6.Save As(A) 

Save the current document to another BLE file. Will prompt for the new file 

name. 

3.3.7.Output the offline files 

Save the current file as the off-line files format˄ ULE format ,˅ Can directly click 

the icon  in the toolbar. The saved offline files can be copied to the device 

through U disk or through the “Send Offline Files”way to sent to the device (via the 

F5 shortcut key to open). 

3.3.8.Recent File 

Shows recent files that you have used. You can click a file name and open it 

directly. 

3.3.9.Exit(X) 

Exit from Plottersoftware. Will prompt you to save if you have edited the open 

documents but have not saved them. 

3.4.Edit Menu 

Click Edit in the Menu Bar, the following menu appears: 

 

 

 

 

 

 

 

(Fig3-4-1) 
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3.4.1.Undo(U) 

Undo the last operation of changing the graphic shape and position. You can also 

use shortcut key Ctrl+Z. 

3.4.2.Redo(R) 

Redo the last operation that was undone. Can use shortcut key Ctrl+Y.   

3.4.3.Copy 

Copy the selected graphic. Can use shortcut key Ctrl+C. 

3.4.4.Paste 

Paste the copied graphic. Can use shortcut key Ctrl+V.  

  

 

3.4.5.Select All(A) 

Select all graphic elements in the document. You can also use shortcut key 

Ctrl-A.    

3.4.6.Sort(O) 

Order the selected graphic elements in the work area. Used to change the order 

that graphic elements are outputted. There are six methods of ordering, including 

three automatic methods: By Row, By Column, Closest First and three manual 

methods: Input Order, Click Ordering and Mouse Guided Ordering. Advice to use 

automatic method first and do fine tuning later manually.  

3.4.7.Create Profile(F) 

    Create outlines for closed path. We can set the distance between the outline and 

the original graphics, set the way of producing outline, the color and whether to keep 

the original graphic when producing outline. 

After paste the graphic color become the first color in the document  
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(Fig.3-4-2) 

Distance: The interval between the outline and the original path; 

Connection: The method for connecting outline; 

Color: The color of outline; 

Enveloping Line: Generating the outline of the selected graphic in order to 

define the engraving area. It largely improves the work efficiency; 

Keep Original: Select to keep original graphic when producing the outline, 

otherwise the original graphic will be deleted (this function invalid for the 

Enveloping Line). 
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3.5.View Menu 

Click “View” in the menu bar, the following menu will appear: 

 

 

 

 

            

 

                ˄Fig.3-5-1˅ 

3.5.1.Toolbar(T) 

Show or hide the toolbar. 

3.5.2.Orientation/Zoom 

Used to set the location and transform for the graphics. 

3.5.3.Color 

Set the color for the graphics. 

3.5.4.Status (S) 

Show or hide the status bar. Status bar shows information about the selected 

menu item or toolbar icon on the left, and shows the coordinates of the cursor. 

3.5.5.Control Flat(F) 

Show or hide the control platform. 

3.5.6.Alignment (A) 

Show or hide the alignment bar. 

3.5.7.Edit (E) 

Show or hide the edit bar. 

3.5.9.Insert (D) 

Show or hide the insert bar. 
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3.6.Setting Menu 

Click “Setting” in the menu bar, the following menu will appear. 

 

 

 

 

                     (Fig.3-6-1) 

3.6.1.System Setting 

Select “System Setting” or press the button F8 will open the system setting 

window (As Fig.3-6-2).  

 

 

 

 

 

 

 

 

 

 

 

 

                                            

(Fig.3-6-2) 

Add: Add new device; 

Delete: Delete the current device; 

Read All: Read in the parameters of all page in device; 

Output All: Output the parameters of all page in device; 
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Apply: Make the current modify valid; 

OK: Make the current modify valid and close the dialog; 

Cancel: The current modify is invalid and close the dialog. 

3.6.1.1.Basic parameters 

Modify: Modify the serial number for the current device; 

Cycle Length: The distance that the head travels when the motor  

turns one cycle; 

Cycle Pulses: The number of pulses output that the motor needs to turn one 

cycle; 

Max.Range˖The size of the work area of the device. This setting has to be 

compatible with the device; otherwise it might cause damage to the device; 

Origin Setting: The logical origin position.  if this axis enabled hard limit 

protection, it should be 2~5mm. If set 0, the axis moves to the min. coordinate 0, 

which might make the limit effective, so will trigger the hard limit protection 

wrongly and the machine will stop urgently. If disable hard limit protection, the 

value can be set 0~5mm; 

Limit Polarity:  it is used to set the high and low level mode of  

spacing/limit signal. When the motion axis arrives at the spacing/limit 

position and input a low-level signal to the controller, the spacing/limit  

polarity should be set to negative at this time; 

Direction Polarity˖Direction polarity modification can move the  

motor to the opposite direction. The modification purpose is to make  

the axis moving to the origin when resetting. If this axis moves far  

from the origin on resetting, it means the direction polarity setting is  

wrong and should be modified;   

Key Start Speed˖it means the starting speed to move the axis by way  
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of the keys on the keyboard˗ 

Shif Accel˖it means the acceleration to move this axis by way of the  

keys on the keyboard˗ 

EStop Accel˖if the “Enable Limit Triger” is used, when the axis  

moves to the position of the limit, it will be Emergency stop operation  

of the axis with EStop Accel˗ 

Max.Start Speed˖it means the speed of the motion axis in direct start 

from the idle condition. If this value is excessively large, it will make  

the motor lose steps, jar and even squeak; if small, it will reduce the  

 running speed of the whole figure. If the inertia of the motion axis is 

 larger (the axis is heavier), you can set a smaller jump-off speed; if  

smaller (the axis is lighter), the jump-off speed can be increased. For  

example, the typical value is 300~1800mm/min˗ 

Max.Speed˖it means the maximum limit of motion speed that this 

 axis can bear. This parameter has something to do with the driving  

force of motor, the inertia of motion axis and its drive ratio. For  

example, the typical value is 12000~30000mm/s˗ 

Max.Accel˖it means the maximum acceleration of the motion axis in  

accelerated or decelerated motion˗ 

Key Reverse: to control the motion direction when move the axis by pressing 

key manually.When set the direction polarity parameters correctly, if press the 

direction key on the panel, the axis will move to the reverse direction, so enable 

this item; 

Single Pulse: Select“Single pulse”for this motor mode, otherwise as “Double 

pulses”˗ 

Enable Reset: if the machine is configured this axis, ‚Reset Enable‛  

should be opened; if no,‚Reset Enable‛ should be prohibited. This  
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parameter is mainly to control the ‚Reset Enable‛option in user  

parameters and ‚axis reset‛ in function keys, to prevent user to reset  

one axis whichis not exist in real˗ 

Enable Limit Triger:it is used for whether the hard-spacing     

protection of this axis is Enabled; 

 

 

 

 

3.6.1.2. Motion Parameters 

 

 

 

 

 

 

 

 

 

     (Fig.3-6-3) 

Home speed˖This parameter determines the machine speed of  

returning to origin. When the machine is larger breadth, to set the  

higher reset speed, but cannot too larger⃞ 

Idle speed:It’s the speed that the device moves in light-off. A higher  

idling speed can shorten the operation time of the entire figure,while  

excessively higher idling speed may cause dithering of the tracks, 

therefore, you should take all relevant factors into consideration  

After modified the configuration parameters in the 

manufacturer parameters, the system should be reset. 

Such a modification can function upon the resetting of 
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when setting; 

Idle acc:match the accelerated speed of air travel time,idle  

acceleration must match idle speed,if set too slow the idle speed may  

can’t reach the value which set before,if set too fast,the mechanical  

structure may not stand and shake.In general,idle acceleration slightly  

higher than move acceleration; 

Idle delay:The extension of time when idle start work; 

Idle acc factor:the coefficient of idle walking speed, the greater the  

ratio, the greater the idle speed; 

Move acc:the speed of corresponding move acceleration 

(move speed is the same as layer speed of layer parameter); 

Move acc factor:the coefficient of moving speed, the bigger the ratio,  

the greater the working speed; 

Start speed:The minimum speed when turning around.The start speed  

can be slowed down when there are many sawtooth in the processing  

graphics; 

    Min acc:It should matched with start speed; 

Speed factor:The accelerated percentage when turning around; 

3.6.1.3.Communication 

 

 

 

 

 

 

(Fig.3-6-4) 
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There are two kinds of connection way :USB and network.Select the connection 

whether through USB or IP,and then click“Connection Test”,if the connection is 

successful,then it is set up correctly. 

 

 

 

 

 

3.6.1.4.User parameters 

    

 

 

 

 

 

 

 

 

 

 

(Fig.3-6-5) 

Drop Delay: It means the delay time set before pen drop down; 

Lift Delay: It means the delay time set before pen lift up; 

Starting Position: The position of  head before start moving . The head will be 

back to this position once the process is done. You can set it to four corners of 

the working area; 

Absolute Coordinate:You can directly check this option when you want the 

1.make sure the device IP and PC’s IP belong to the same 

network segment; 

2.if PC can be connected to equipment, but can not send 

data, check the PC’s network firewall-related settings; 

3.WIN7 and above operating system, please set the 
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graphics location in the graphics display area corresponding to the actual work 

location of processing. Then the graph position will be no longer related with the 

actual output position of the head and orientation point, but always regarding 

mechanical origin as the anchor point. 

Return position: the mechanical origin, the locating point and no  

return, this parameter decides the head stop position when  

finished each processing.Drive. 

3.6.2.User Parameters 

Quick open the user parameters in the system settings.    

3.6.3.Run Setting 

 

 

 

 

 

 

 

 

 

 

 

 (Fig.3-6-6) 

Device: Information about the selected Device, press attribute to see  

    the parameters of system setting; 

Save as off-line file: Whether to output the file and save as off-line file; 

Output Range:  
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All: Select this button can run all graphics in work area; 

Selected: Select this button can run the select graphics in work area; 

Startup Mode: The machine is set as automatically start, manually  

start and continuous start, if choose the automatically start, then the  

file sends over, , the device will start to run the file, but the manual  

start requires human intervention to run the file, continuous start refers  

to keep running the same file, it requires human intervention only  

when the running start, you can set the number of continuous  

operation and the time interval between the two runnings; 

Send Offline File: Send the saved off-line file to device; 

Center Position: Before run the file, the head will be sent to center position of 

the graphics;   

 

3.7.3.Preview (V) 

 

 

 

3.6.4.Smoothing Setting  

 

 

 

 

 

                         (Fig.3-6-7) 

    Curve divide precision:It means precise value of divided curve. 

Smoothness:The curve will more smooth when the accuracy is high. 

 

Choose the device in pull-down menu, will display in status bar 

whether it is successfully connect on with the current device, 

When send or deal with data, we can see the degree of progress. 
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3.6.5.Grid Setting(G) 

Settings about grid, whether to show the grid, to snap to the grid and the style of 

the grid etc. 

 

 

 

 

 

 

 

 

  (Fig.3-6-8) 

Horizontal Gap: Horizontal distance between two neighbor grids lines; 

Vertical Gap: Vertical distance between two neighbor grid lines; 

Show Grid: Whether to show grid in the view or not; 

Snap to Grid: Whether to snap the graphics to the grid position when 

they are moved; 

Style: Style of the grid, could be Dot, Line or Dot and Line; 

Snap Mode: Which point of the graphics to snap to grid. 

3.6.6.Options(O)   

 

 

 

 

 

 

(Fig.3-6-9) 
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    StartUp     

        Auto-open recent files:The screen appeared in the interface of  

        open software.(it will no appear startup screen if do no select this  

        option);        

    File Import 

        DXF Char Remove: Whether skip the text when loading a DXF  

        file; 

        CorelDraw 11 PLT: The size of the graphics in the PLT file  

        generated by CorelDraw 11 is smaller than as designed. With this  

        option checked, graphics from all CorelDraw PLT files will be  

        scaled up to 101.6% to compensate. Check this if you are using  

        CorelDraw 11; 

        DXF Arc Keep: When loading a DXF file, set the Arc change to  

        curve or not; 

        PLT Vertical Mirror: If you select the PLT Vertical Mirror,  

        when input the PLT file, the system will automatically turn this  

        file into the vertical mirror and output it; 

        DXF Vector Merge: When loading a DXF file, whether connect  

        the line segments into a path when they are close to each other, so  

        that the working can go quickly; 

        Auto Smoothing: Auto smooth the input graphics to make  

        working much more successful. You can adjust the smoothing  

        parameters in its setting menu bar to get better result; 

        Auto-optimize path start:Automatic optimize the graphics’ 

        origin to corner,and the offer a speed and a effect; 

        Auto-Mirror Horizontally: Auto horizontally mirror when  

        import a file; 
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Save  

    Auto Save: Select “Auto Save”,set time interval, when close the            

dialog ,after a few time, the system will save a recoverable file in 

the“Recoverable File”. 

Process 

        Modify file name: allow to modify file name before file send to machine .       

3.7.Help Menu 

Select “Help” in the menu bar, the following menu will appear as Fig.3-7-1:   

 

˄Fig.3-7-1˅                        

3.7.1.User’s Manual 

Launch the online User’s Manual. You can select “User’s Manual” in Help menu 

or press F1.  

3.7.2.About Plotter(A) 

Click this icon  in toolbar, Displays the version and copyright information. 

Users can get the latest information, technical substance, software upgrade through 

the web of Boye Laser, and can also contact with Boye Laser Company through 

phone, fax and email and so on. 

 

 

 

 

 


